Equity, Diversity and Inclusion-Minded Practices in Virtual Learning Communities

Jill Provoe, Senior Advisor, Educational Equity
Nova Scotia Community College
Acknowledgements

This document was created by Jill Provoe, Senior Advisor, Educational Equity, with support from Dr. Jeff Taylor, Associate Vice President, Applied Research & Innovation from the Nova Scotia Community College (NSCC). The inspiration to write this document, along with much of the content, came after watching “Employing Equity-Minded and Culturally-Affirming Teaching and Learning Practices in Virtual Learning Communities” on YouTube; special thanks are in order to Dr. Frank Harris III and Dr. J. Luke Wood for facilitating the session.

This document was initially developed for the NSCC community. In an effort to expand its scope and applicability, a working group was formed to discuss best practices in virtual learning communities, and to assist with revising the document. The working group was composed of signatories to the Dimensions charter, a component of Dimensions: equity, diversity, and inclusion Canada. Working group participants provided diverse perspectives as well as valuable feedback in the development process. Within the working group meetings, there were critical and beneficial discussions regarding institutional realities, intersectional approaches, and equity recommendations, which helped curate the final version of this document. Many thanks go out to Ann-Barbara Graff (Nova Scotia College of Art and Design University); Sula Levesque (University of New Brunswick [UNB]); Caen Squires (UNB); Dave MaGee (UNB); Derek Fisher (Mount Saint Vincent University); Geneviève Lapointe (Université Laval); Gwen Hill (Royal Roads University); Ian Crookshank (Humber College); Jennifer Davis (Lethbridge College); Marni Stanley (Vancouver Island University); Nicole MacDougall (Cape Breton University); Rowan Thomson (Carleton University); Theresa Burley (Simon Fraser University); Yunyi Chen (University of Manitoba); and the Dimensions team for sharing expertise and lived experiences to determine intersectional considerations to ensure this document is as inclusive as possible.

Preamble

This document was developed within the COVID-19 context of ‘emergency remote teaching’, but we hope that it will serve as a helpful guide for all virtual environments, including research settings. As teaching has gone online, so has research and research mentoring; Access to research labs, facilities, field work, and productive work spaces has been dramatically impacted by the COVID-19 lockdown, and this has in turn impacted students as researchers and research assistants in significant ways. A recent survey found that 75% of graduate students in Canada say their research has been negatively affected by COVID-19.¹ Some research teams are small, with one principal investigator and a few trainees, while others are large, sometimes comprising a research network, leading to varying kinds of team interactions. Considering these kinds of details is important when addressing equity in the research environment. The principles, strategies, and practices outlined in this document are intended to support teachers in the classroom but also faculty working as research supervisors and mentors.

With that being said, we recognize that there are limitations to this document; it should not be considered the quintessential guide. Rather, it should be regarded as a starting point for people to learn from and then continue to do the work themselves. Educators and researchers should constantly look for training opportunities so they can continue to learn and grow within a self-guided method. We also recognize that terminology we use within the document may not reflect terms used within each unique institution.
Introduction

“Being race conscious and aware is more important now than ever before.”  
Dr. J. Luke Wood

Equity-minded teaching and learning practices, no matter the modality, call on us to look at systemic barriers to achieving educational equity in the learning environment. The approaches outlined here are aimed at improving and enhancing the learning experience for everyone in support of equitable student success.

It is important to begin this guide by defining Universal Design for Learning, as this concept appears throughout the document, which is: “an educational framework that guides the design of learning goals, assessments, methods and materials, as well as the policies surrounding these curricular elements, with the diversity of learners in mind.”

One of the major challenges in online teaching is that it is easy to think that equity and inclusion are not as important because we don’t see the students in the same way as we do in a classroom. This might lead us to believe that diversity is invisible. However, if we ignore the diversity we don’t see, we risk creating hostile online learning environments for students from equity-seeking groups.

These are unprecedented times and it is important to see the opportunity that distance learning presents to do things that you haven’t done before and to ensure you reach all students. This document has been developed towards ensuring our commitment to equity, diversity, and inclusion (EDI) stays strong despite the changes and challenges virtual learning creates. As instructors adjust to these new teaching platforms, and as we all adjust to new ways of engaging in learning together, this document acknowledges that some may have never taught virtually before and serves as a practice guide to help ensure no student feels forgotten. The suggestions in this document serve as considerations and are not being presented as the only ‘right way’ to do things. We understand and recognize that these transitions won’t be easy - people will falter throughout their EDI work, whether they're an EDI novice or expert, faltering is okay as long as you remain accountable and take the time to learn from those missteps. The primary goal is to keep your students safe and, therefore, taking ownership of your mistakes and continuing to learn and grow your equity practice is critical and will allow you to come back stronger than ever.

Personal Learning Plan/Teaching Philosophy Statement

Instructors could consider developing a personal learning plan, or teaching philosophy statement as an initial step to track their own personal learning and growth around EDI. An EDI teaching philosophy statement provides a written description of your values, goals, and beliefs as they relate to equity, diversity, and inclusion in teaching practices. A personal learning plan or teaching philosophy will help track your short-term and long-term EDI goals, and help to hold you accountable for your growth.

A We recognize that terminology is constantly evolving. Throughout the document, we will be interchanging the terms ‘equity-seeking’ and ‘equity-entitled’. We believe it is important to rethink the way equity is framed. Marginalized communities are seeking equity, but, as human beings, they are also entitled to it.
When developing your plan/statement, you should ask yourself the following questions: what are my values, goals and/or beliefs about who has access to learning? How do I show up to teach in ways that support all learners? For each value/goal/belief, specific examples of demonstrable teaching practices (existing or aspirational) should be provided. For example, the statement “I believe all learners should have access to required reading materials” reflects the value of inclusion, and could connect to a demonstrable practice of providing options such as audio files, speech-to-text friendly resources, or other options for students.

Developing an EDI teaching philosophy statement doesn’t need to be a massive undertaking. It is an easy way to summarize the type of educator you strive to be, provides accountability to help you achieve your goals, and will ultimately help to make your learning atmosphere inclusive and equitable for all students.

Six Equity-Minded Practices for Teaching Online

“Our job is to create a net of support so tight that students cannot drop through it.”

Dr. Frank Harris III

Equity is about enacting intentional strategies to address disparities that affect students who are already disproportionately impacted. As a learning community, we must also advance Digital Equity which considers issues of access to technology and Wi-Fi, and also the role of technology in optimizing teaching and learning innovation and enabling cutting edge research.

We will do this by leveraging new digital tools and open practices while giving due consideration to whose voices are dominant online and whose are excluded across all platforms.

Here are six equity-minded strategies for teaching online with practical tips to help you implement them in your courses in pursuit of educational equity:

1. Be Proactive
2. Be Relational
3. Be Culturally-Relevant and Affirming
4. Be Community-Focused
5. Be Race Conscious with an Intersectional Lens
6. Be Accessible

Be Proactive

Reach out to your students often and engage purposefully and positively.

- Conduct an informal assessment of students’ experiences in online learning. Ask: Is this your first time taking an online course? How are you accessing the course? What concerns do you have about this course? How can I best facilitate your learning? Are there any supports/considerations you want me to be aware of and/or I can help implement?
• Create an online classroom that is portable and can be viewed using a handheld phone for students who do not have access to all of the tools they may need, such as a laptop, camera and microphone. The phone allows students to connect more flexibly to the classroom.
• Prepare and email students a brief orientation video (and be enthusiastic!) that introduces them to their online platform (such as Brightspace, Blackboard, Moodle, etc.) and any other technology they will need.
• Consider students in other time zones: provide asynchronous alternatives; record all classes (if possible) and make them available to all students. This will also introduce students to you and may make them feel more comfortable reaching out if they need support.
• Make success in the course transparent; give tips such as necessary resources and ways to approach the readings and/or assignments.
• Use assessment strategies that focus on continuous improvement and progress toward demonstrating proficiency by the end of the course.
  o For example, use smaller assignments with lower point totals vs. larger assignments with big point totals; feedback should be personalized to the extent possible; offer Credit Earned grading options, when appropriate.
• Monitor performance closely for the purpose of catching problems and addressing them before it’s too late. Loss of points for attendance and submitting assignments discourages students from persisting. We want to do everything possible to ensure our students stay on track as we transition to distance learning.
• As a research mentor: Research activities often require significant organic conversation to stimulate critical analysis and problem solving. Recognize that some students may require more virtual engagement than others in stimulating this line of thinking. Be patient with this sort of virtual communication and be cognizant of inter-cultural communication differences as you encourage continuous dialogue about project progress.
• Intervene: Use early warning systems to help students who are not turning in assignments, such as a phone call and words of encouragement; reach out before things get out of control.
• Encourage Help-Seeking: Recognize that some students, such as Black and Indigenous men, struggle with help-seeking due to social stereotypes.
• Make Referrals: Connect students with specialized supports, where possible, such as Student Services Advisors, African Canadian, Indigenous, and International Supports or others who have high expectations of them and care about their success.
• It is vital to connect them to ‘people’ not ‘services’ and to do a ‘warm hand off’ to this person, when possible (i.e. email introduction; set up a virtual meeting time for you, the student, and the person to whom you want to refer your student).

Be Relational

Authentic relationships between students and faculty that are grounded in trust, mutual respect and authentic care – be that in person or online – are critical for student success.
• Create the conditions for these relationships to emerge.
• Avoid the ‘ask-me-first/ approach-me-first’ philosophy.
• Demonstrate an ‘authentic investment’ in student success; this is one of the most significant predictors of student persistence.
• Humanize yourself; share your story, to the extent that you are comfortable in doing so.
• Learn at least one thing about each student that has nothing to do with them as a student, such as the significance of their name, hometown, hobbies, talents, favorite book, movie or music artists.
• Whether in the classroom, or on a virtual platform, you are encouraged to share your pronouns with your students, if comfortable, and to invite your students to share theirs so you can learn their pronouns as well; doing this normalizes pronoun use in your learning space, establishes the importance of their use in creating a safer space for equity-entitled students to self-identify, and models the practice of challenging our audio-visual assumptions.
• Educators should try to avoid the term ‘preferred pronouns’, as they are not a subject of preference, but rather a statement of fact.
• Invite students to create short videos introducing themselves to one another as an early way to start building meaningful relationships.
• Convey unconditional positive regard; see your students as being fully capable of being successful; approach them in non-judgmental ways.
• Hold high expectations for performance – for your students and for yourself.
• Reject deficit perspectives about students’ intellectual capacities or their ‘fit’ for post-secondary study; validation and positive messaging are critical.
• Students must hear ‘you belong;’ ‘you can do the work;’ ‘you can succeed;’ ‘you have the ability;’ and ‘you are intelligent.’
  o For many of students from equity-entitled groups, you might be the first educator to say these things to them.
  o Seek opportunities to say them verbally and when giving feedback on assignments.

Be Culturally- Relevant and Affirming

A culturally- affirming learning experience entails educators’ ability to connect course content to students’ lived experiences and cultural contexts.  

• Acknowledge and leverage the cultural strengths and assets of your students to facilitate learning.
• ‘Mirror’ diverse students in course content, perspectives and materials so your students see themselves in their learning.
• Be culturally-relevant and teach in a way that honors the lives and background of the students you are serving; this not only addresses students’ unique cultural experiences by enhancing their growth, learning and success, but it actually contributes to the learning of all students.
• Select resources and texts that are inclusive; students from equity-seeking groups often report that their voices are absent from learning resources – it is important to choose materials that validate the experiences of all learners as much as possible.
• Embrace Universal Design for Learning and use variable assignments and forms of assessment. Give students choice in how they can best demonstrate their learning.
• Consider the images you use in your virtual platform pages, online learning tools, and PowerPoints. If you use stock photos, ensure you consider race/age/gender/ability and other forms of diversity in your selection.
• The aesthetic of the online environment is important and can help all students to feel welcome.
• When students see images that are reflective of themselves and highlight their contributions to society, research shows they will have increased self-esteem, increased confidence in their abilities, greater sense of belonging and greater resilience.
Be Community-Focused

It is vital to build community in online learning environments so that students feel connected, engaged and supported.

- Develop strategies for building community online, including mandatory interactions and group activities.
- Be present in all aspects of your course and model the engagement you expect of students.
- Introduce yourself in a short video and invite students to do the same.
- Be active in class discussion boards and group chats/forums.
- Establish community norms – agreed upon by both students and faculty – to establish expectations for communication, expectations for how you will give and share critical feedback with one another, appropriate language and expectations for how you will give and share different perspectives.
- Invite students to share their camera during synchronous class sessions, if they are comfortable doing so, while being mindful of both personal preference as challenges/limitations with access to technology.
- Provide opportunities for students to engage outside of class such as online study groups, virtual meet-ups and class social media pages.
- Use group learning for longer term projects. It is important to give students the tools they need and don’t assume they already know how to work together just because they work collaboratively in other spaces.
  - Create guidelines and give students rubrics that allow them to assess themselves and have periodic check-ins with groups to assure it is a positive experience for all students.
  - Be mindful of how you go about forming groups, as self-selection can be marginalizing for some students. Think about ways you can get students to work collaboratively by intentionally creating groups.
  - This allows students to build community, share their personal perspectives, realize the knowledge they already have, learn from one another, identify others who may be experiencing similar learning and life challenges and to assume leadership roles.

Be Race Conscious with an Intersectional Lens

Race is a salient factor when discussing inequities and marginalization which means the impact and trauma of systemic racism must always be top of mind. You are also reminded about the importance of not making assumptions about your students based on race and be mindful of other identities they bring and be in service of those, as well. This is about connecting to the diverse life experience of the students we serve.

- Be transparent and vulnerable with your students. Admit when you don’t know and acknowledge that you don’t know everything about these topics and will make mistakes along the way, but that you are willing, and working, to actively learning.
- Be intentional about providing opportunities to engage racial and equity issues within the context of the course.
- Understand microaggressions and how they might manifest themselves in online environments.
- Stay present in the dialogue; monitor it regularly and intervene when necessary.
- Critically reflect upon your own role and responsibilities in removing systemic barriers to equitable success. Do not attribute outcome disparities exclusively to perceived deficits in students’ identities, life circumstances or capabilities.
• Give students the tools they will need to productively engage in discussions about race and other forms of oppression in the course.

• Make sure you have the tools you will need to facilitate this dialogue – expose yourself to the research on microaggressions so that you understand what they are and how they might manifest in an online environment.
  o Examples of resources include:
    ▪ See Appendix 1 for Additional Resources.

• Be an Antiracist Educator by:
  o Seeking to understand the nature and characteristics of the barriers created by systemic racism.
  o Being committed to dismantling the systems and structures that institutionalize racism in your learning environments.
  o Critically examining your teaching practices by inviting voices and perspectives from racialized students and honestly reflecting on those experiences.
  o Assessing the quality of your teaching against the success of all students (McKamey, P., 2020, CRRF, 2015).
  o Invite guest speakers from marginalized and intersecting communities to offer their voices and lived experiences to your class.

• Educate yourself so that you are well prepared to engage in a discourse about race and other forms of oppression and to address microaggressions when they occur while simultaneously recognizing your limitations in your knowledge. You have a responsibility to ensure that no students are being marginalized in your online classes.

**Be Accessible**

For students to use assistive technology effectively, anything posted on your virtual classroom, or made available electronically to students, has to be accessible. Consider the following key ideas when creating materials for your course.

**Styles**

• Use Styles in order to format your document. Do NOT use font formatting to style text;
  o For example: When making a heading, select from the options provided in Styles (Heading 1-5; Title; Quote; etc.). Do NOT make it yourself by changing the font, size, colour, etc. provided in Font.

• Style elements have a different look from the others (i.e. Heading 1 looks bigger than Heading 2 etc.);

• Make sure Heading levels are correctly ordered; pages should be structured in a hierarchical manner, for example:
  o Heading 1 is usually a page title or a main content heading. It is the most important heading, and there is generally just one.
  o Heading 2 is usually a major section heading.
  o Heading 3 is usually a sub-section of the Heading 2.
  o Heading 4 is usually a sub-section of the Heading 3, and so on, ending with Heading 6.
Fonts
- Use 12 point or larger;
- Be consistent with the fonts used in the document;
- Use a sans serif font – such as Arial, Helvetica or Verdana;
- Using italics or upper-case letters for emphasis is not recommended – see note above on Styles.

Colours
- Use appropriate colour contrast (e.g. black and white). Use a contrast checker if you’re not sure;
- Make sure that all information conveyed with colour can also be conveyed without colour;
- For print documents use a matte/non-glossy finish.

Spacing
- To start a new page use the Insert tab then Page Break. Don’t press Enter repeatedly to start a new page;
- Adjust spacing through the Paragraph formatting menu; avoid pressing Enter multiple times to create blank space;
- Space between the lines should be at least 25-30% of the point size;
- Left-aligned text is the most readable. Avoid justification or centering.

Images & Alternate Text
- Set wrapping style of non-text elements as ‘In line with text’;
- Add alternative text to graphics and images to provide information about the content or function of the image;
- Keep the Alt text simple and short;
- Avoid text boxes and Word Art as they may be inaccessible to screen readers;
- Avoid using watermarks and background images.

Lists and Columns
- To insert a column use Page Layout tab then Columns;
- Avoid using spaces and tabs - they will not be recognized as a column by screen reading software programs;
- Use structure for a list, either ordered (eg. Numbered) that follows a sequence (eg. Steps) or unordered (bulleted) for a group of items without a sequence.

Tables
- Use the Insert tab then Table to properly insert a table into your document;
- Use proper Table Headings and check the Header Row check box (use Styles to format table);
- If a table is longer than a page, Heading Rows must be repeated at the top of the table on each of the subsequent pages.

Hyperlinks
- Ensure that the Hyperlink has context and describes where it leads;
- Avoid using ‘Click here’ or ‘More info’ as a link title as these are difficult to understand out of context;
- Do not use the raw URL as the link;
• Be aware that some students living outside of Canada may not be able to access some links as website and application access varies (e.g. YouTube is not available in some countries). These students will require accommodations; consider downloading videos or documents to then share with them.

**Graphs and Charts**

• Add a short caption preceding the chart or graph to describe the content;
• Provide an alternative presentation or summary of any findings;
• Ensure that colour contrast is not the only means of communicating information.

**Page Numbers**

• Do not manually type the page numbers. Use the Insert tab then select Page Number to add a page number to your document;
• If your document is longer than 20 pages, create a table of contents using the ‘References’ tab.

**Virtual Platforms and Videos**

• When using online platforms (Zoom, MS Teams, Webex, etc.) investigate the ways you can incorporate closed captioning into your classes. These instructions can often be found by searching the platform name and ‘closed captions’ on the internet. Many platforms involve designating someone as the captionist to type what is being said in real time. Closed captions are beneficial to those who are hard of hearing, but also for those who are visual learners, or who are neurodivergent.
• Educators should be aware of their class content. For example, if posting videos on your classroom space for students, you should ensure that the video provides accurate closed captioning.

These principles of content accessibility, as well as others such as including closed captions for videos (For example clips shown as part of class content) and live content delivery, are part of Universal Design for Learning. Further resources to help make remote learning accessible and inclusive using the principles of UDL can be found here: [http://www.cast.org/whats-new/remote-learning-resources.html](http://www.cast.org/whats-new/remote-learning-resources.html)

**Harassment/Discrimination, and Mediation Strategies**

**Students as Targets**

Similar to in-person experiences, harassment and discrimination are present in online communities. Educators should be aware that these events may occur in their virtual classroom: “Internationally, researchers have also begun documenting the prevalence and characteristics of cyberbullying and related behaviours at the university and college levels.” Studies have shown that marginalized communities are more likely to be targets; those identifying as LGBTQ2S+ are twice as likely to be targets of online harassment. Educators should inform students of institutional policies and consequences regarding discriminatory actions/language (often found in the institutional Code of Conduct). Another action that educators may take is to have students review or sign your own Code of Conduct with regard to classroom discussions/behaviours prior to the beginning of the course. This may help either stop harassment/discrimination before it starts by indicating that there are consequences.
attached and making it clear what is included in its definition, or help after the fact to demonstrate that the perpetrator was aware of consequences.

Educators should familiarize themselves with the settings of the virtual spaces. Some platforms allow moderation tools to help manage online forums; for example, some settings require that comments be approved before they are posted (recognizing that this may become labour-intensive depending on the size of the class and volume of discussion). Educators should also familiarize themselves with local level resources when dealing with harassment and discrimination so they know where they can advise their students to turn to; consider including this information in class syllabi.

If you notice a student being harassed or discriminated against through a class discussion page or other virtual classroom locations, you should call out the behaviour; make the students know that you see it happening, and that it is unacceptable. Remind students that your ‘classroom’ is a safe learning space for everyone. If the harassment/discrimination persists, have a conversation with the perpetrator(s) and inform them of the institutional and legal consequences that can happen. Also have a conversation with the target to ensure they have the supports they require to process and heal. If the target chooses to file a complaint with the institution, stand with them through the process. If the harassment/discrimination is written in a classroom space, document it; if it has been spoken in a recorded lecture, save the recording to support the target’s case. Educators should recognize that harassment/discrimination can also take place in ‘invisible spaces’ in the virtual classroom that you may not be privy to, for example, private messages. Consider encouraging students (whether written within a classroom Code of Conduct, or verbally stated at the beginning of the course) to record/document instances of private harassment and inform educators so they may follow up accordingly (consider the steps listed above). Educators could consider completing some extended learning and discovery into Safe Spaces training or talking to their resident supports.

If a student informs you that they are the target of harassment and discrimination, it is important that you take a position of validation. Include reinforcing statements like, ‘what you experienced was not okay’, ‘I see/hear you’, ‘let’s figure out what options we have to address that’ when talking to your student. It is also important to include a sense of vulnerability that mirrors reality by including a statement like, ‘I can’t guarantee the possible solutions are fair or right.’

Educators should be aware that sometimes perpetrators can anonymize their identity in virtual public forums (as seen with recent ‘zoom raids’). It is important for the institutions to ensure that the virtual spaces they choose/use for student interactions are secure/private, and it is important for educators to know how to use the security settings to ‘lock’ classroom spaces so only students can access them.

**Educators as Targets**

Educators can be targets of harassment and discrimination within their own classrooms. When this happens, educators often experience greater emotional labour while striving to maintain “professional composure while withstanding emotional distress,” along with other negative mental and physical impacts. Similar to students, staff and faculty who identify with the LGBTQ2S+ community are more likely to be targeted, thus “highlighting the interplay of gender, race, ethnicity and sexuality (intersectionality) when it comes to bullying.” By familiarizing yourself with local level resources when dealing with harassment and discrimination, you will know what channels you can access if you are the target. In such incidences (whether perpetrated by students, or colleagues), inform your Chair/Dean,
Union, and Human Rights Officer to help intervene in the situation. Similar to when a student is the target, record/document the harassment/discrimination to support your claim(s), if possible. If you feel your institution does not have adequate policies on harassment and discrimination, consider initiating conversations to alter and adopt more comprehensive policy changes.

Concrete Actions to Implement

**Academic Commitments**

Consider making the following commitments to show students your dedication to creating an equitable, diverse, and inclusive learning space.

- To make decisions grounded in a collective commitment to accessibility and educational equity, by asking who can or cannot engage and why;
- To leverage technology while advancing digital equity considerations in planning for flexible delivery;
- To encourage students to bring their own devices and to find appropriate supports for those who cannot.

**Resource Equity**

Give due consideration to the dimensions of Resource Equity that supports academic excellence. Resource Equity is the allocation of resources – people, time, and money – to create student experiences that enable all students to achieve equitable outcomes no matter their race, income, gender identity, sexual orientation, or other form of diversity. In recognition of the fact that some communities have been disproportionately impacted by COVID-19, we have to redress these inequities by bringing an equivalent level of support back to them. Therefore, it is vital that we allocate resources from an equity lens to ensure that all students are supported through inclusive economic recovery and growth strategies.

**Digital Equity**

Educators can encourage their institutions to consider these points to advance digital equity and the role of technology in optimizing teaching and learning innovation:

1. **Leverage new digital tools and open practices.**
   a. Put laptops into circulation to be loaned to students, and secure funds to further advance the ability to support student technology needs.
   b. State in official planning guidelines that students without reliable, affordable high-speed Internet and mobile connectivity will be given priority access to the campus to enable utilization of institutional Wi-Fi, computer labs, and Learning Centers to engage in their learning.
   c. Consider launching an Open Educational Resources policy in recognition of the fact that Open Education helps to not only enhance equitable access to institutional education by reducing financial burdens on students, but also positively impacts teaching and learning innovation.
2. Pay close attention to whose voices are dominant online and whose are excluded across all platforms and ensure spaces are safe for all students to speak up and to engage in their learning.
   a. This aspect of digital equity is critical and its importance is often missed in discussions about access and equity.
   b. Supporting institutional learning is important so students are not unintentionally marginalized in virtual learning communities. Institutions could consider building an equity page to help keep equity considerations top of mind from a teaching and learning perspective.
   c. Leadership is second only to teaching with regards to impact on student outcomes. Institutions could, therefore, promote learning and understanding of equity-minded leadership practices across all levels of the organization so that everyone is working to ensure that the most vulnerable students are not lost in this time of interruption.

Closing

It is imperative that we keep equity at the forefront of the virtual learning and research communities that we design and deliver to our students. Have grace with yourself through this transition – and have grace with your students! Continued professional development in this area is critical; deepen your knowledge and your learning of equity-minded practices to build your capacity to make these strategies actionable in any distance learning environment.

These practices are recommended to maximize support for students from equity-entitled groups, but remember that they benefit all students!

Keep in mind that we are going through tumultuous and difficult times. Instructors need to take care of themselves to ensure their physical, mental, and emotional health. Educators are not expected to be perfect in their EDI work, however learning educate through an equity lens over time is essential to your practice. While you may still be learning, it is vital that you do not cause harm to your students. You must be open and willing to learn from mistakes. If you do or say something to cause harm, take full responsibility, apologize and learn from it so that it doesn’t happen again. Remember, we are in this together and you do not do this work alone. Reach out to experts in your own communities if you ever find yourself needing more support.

References:

- NSCC Digital Accessibility Checklist.
- Web Content Accessibility Guidelines (WCAG) 2.0
Appendix 1: Various Resources

Articles:
- 10 Ways Well-Meaning White Teachers Bring Racism into our Schools.
- The Power of Teachers to Transform.
- Decolonizing the classroom is more than just a checklist.
- What Antiracist Teachers do Differently.
- Truth and Reconciliation in YOUR classroom.
- Letter to Western’s senior leadership with 13 action items.
- The Auntie who helps Indigenous students adjust to college life.
- Guide to Acknowledging First Peoples and Traditional Territory.

Journal Articles:
- How Equitable can we Get?, Usher, 2019.
- Can This Man Change How Elite Colleges Treat Low-Income Students?: Anthony Jackson beat the odds. His research focuses on those who don’t, Quintana, 2019.
- Mentoring Across Differences, Osman & Gottlieb, 2018.
- Science faculty’s subtle gender biases favor male students, Moss-Racusin, Dovidio, Brescoll, Graham & Handelsman, 2012.
- Indigenization as inclusion, reconciliation, and decolonization: navigating the different visions for indigenizing the Canadian Academy, Gaudry & Lorenz, 2018.
- Inclusion and accessibility in STEM education: Navigating the duty to accommodate and disability rights, Prema & Dhand, 2019.
- The link between LGBTQ-supportive communities, progressive political climate, and suicidality among sexual minority adolescents in Canada, Saewyc, Li, Gower, Watson, Erickson, Corliss & Eisenberg, 2020.
- Coming out in STEM: Factors affecting retention of sexual minority STEM students, Hughes, 2018.
- Together but Unequal: Combating Gender Inequity in the Academy, Roos, 2008.
- Adding Sex-and-Gender Dimension to Your Research, Rabesandratana, 2014.
- Speaking up for what’s right: Politics, markets and violence in higher education, Phipps, 2017.
- **A safe place to learn? Examining sexual assault policies at Canadian public universities**, Lee & Wong, 2017.
- **To reduce gender biases, acknowledge them**, Chachra, 2017.

**Reading List:**
- **Social Research and Disability: Developing Inclusive Research Spaces for Disabled Researchers**, Burke & Byrne, 2020.
- **Black Racialization and Resistance at an Elite University**, Hampton, 2020.

**Lesson Plans and Curriculum Resources:**
- 100 ways to Indigenize and decolonize academic programs and courses.
- Teaching Tolerance.
- Resources for Decolonizing your Teaching.
- Open Source Anti-Racist Lesson Plans & Resources for Educators.
- 21 Free Social Justice Resources for Teachers.
- "It's Our Time" Assembly of First Nations Digital Toolkit.
- Culturally Responsive Curriculum Scorecard.
- Truth and Reconciliation in Post-Secondary Settings: Student Experience.
- How to integrate sex, gender, and intersectional analysis into research.
- Unconscious Bias: From Awareness to Action.

**Podcasts:**
- Teaching While White.
- Challenging White Supremacy in Schools.
Tools:
- menti-meter: https://www.mentimeter.com/
- Klaxoon: https://klaxoon.com/fr/
- Google Doc or Slide for creating content
- Kahoot: https://kahoot.it/
- B12: https://www.b12.io/

Reports
- Sexual Harassment and Violence in the University Context: Report from the Task Force on Policies and Procedures Pertaining to Sexual Harassment and Violence (GT-PHS).

Appendix 2: Educators to Follow on Twitter
This is small sample of educators to follow.
- Dr. Sheila Cote-Meek: @SheilaCoteMeek
- Dr. Sheldon L Eakins: @sheldoneakins
- Dr. Ibram X. Kendi: @DrIbram
- Raul Piña: @RaulPinaAZ
- Dwayne Reed: @TeachMrReed
- Ken Shelton: @k_shelton
- Dr. Malinda Smith @MalindaSmith
- Sabrina Joy Stevens: @realsabijoy
- Dr. Sarah Thomas @sarahdateechur
- Joe Truss: @trussleadership
- Jose Vilson: @TheJLV
- Indigenous Educators’ Network: @IENatOISE


3 “Writing a Teaching Philosophy Statement.” Centre for Teaching and Learning, Western University Canada.


7 Ibid.


9 Ibid.